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Learning objectives: 

At the end of the course you will be able to: 

 

 Use EndNote to store details of material you have read 

 Import records from Library databases 

 Use the group options to manage references  

 Insert citations from EndNote into a Word document 

 Format and unformat the citations in your Word document 

 Create a bibliography from EndNote 
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Need more help with EndNote? 

TRY … http://www.library.auckland.ac.nz/endnote/endnote.htm  ...  OR  …  http://www.endnote.com 
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PART ONE 

 

What is EndNote?  

EndNote is a specialised database program for storing and managing bibliographic references. It allows you 

to copy references from Library catalogues and bibliographic databases. You can add your own notes, 

rankings, subject headings, and useful quotations to the references. The references can be sorted and 

searched, and incorporated automatically into papers for publication.  EndNote makes writing academic 

papers easier, not only by saving you time, but also by ensuring your references are cited consistently. 

 

EndNote Library 

 

 

 

 

 

To create a new library: 

 

1. Open the EndNote programme from the menu: 

Start >> Programs >> EndNote >> EndNote Program (if you get a screen pop-up asking you to create 

an EndNote Web account – click cancel) 

2. Click the image next to the option Create a new EndNote library.  EndNote will present a dialog box 

to name and save the file. 

3. Enter a name for your new library in the File name area. 

4. Click Save. In this tutorial your library should be saved to the Desktop. 

5. The new file is an empty EndNote library, showing “0 out of 0 references.” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EndNote Terminology 

An EndNote file is called a library. It is a database containing a separate record for each reference. 

Each record is made up of several fields containing specific pieces of information. 
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One Library  

 

While it is possible to keep more than one library, it is recommended that you only have one library.  If you 

insert references from different libraries into the same Word document there can be problems with 

formatting and reference double-ups.  You can use the groups, notes and search features of EndNote to 

effectively manage a large library.  Some fields in a reference can have about 10-12 pages of text, e.g. you 

can have 10 pages of your own research notes in addition to all the other information about the reference. 

 

Manually Enter a Reference 

 

To input reference information manually: 

1. References >> New Reference      

2. A blank New Reference appears. 

3. Choose the Reference Type from the drop-down  

       box 

4. Enter the reference from this sample cover page: 

 

 

 
 

 

 

 

 

Once all data has been entered close the reference window (CTRL+W).  EndNote will ask if you want to save 

the information, click yes.  The new reference will now display in your library. 

If you need to make changes to a reference after you have closed it, open the reference, make the changes, 

close the window and click yes in the pop-up box to save the changes. 

 

Reed Books 

Auckland, N.Z.  2015 

The Reference Type box is at the top of every new reference, indicating 

the type of reference being entered.  Journal Article is usually the 

default reference type, but you can select any other type from the 

drop-down list. 

Use the Enter key to create a new line in a field, e.g. for another author.  

Use the Tab key to move down the fields.  

Use the Shift+Tab keys to move back up the fields. 
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Names 

• There are several ways to enter author (or editor) names, either: 

First Middle Last   e.g.  D H Erwin 

OR 

Last, First Middle   e.g.  Erwin, D H 

• Only one author name can be entered per line. Press Enter to get another line. 

• If you are entering initials instead of full names, make sure there is a space between each initial. 

• If your author is a corporate body e.g. Manukau City Council you must put a comma after the last 

part of the author name e.g. Manukau City Council,   If you omit the comma then EndNote will 

interpret this as an individual author and output it as e.g. Council, M.C. 

• As you enter author names you may notice that some appear in red. Any text that appears in red is 

part of a term list.  These are used to help with data entry by suggesting terms as you type. 

• For further information on entering names, including authors with suffixes and corporate authors 

that already include a comma in their name, consult Chapter 4 of the full EndNote manual: 

http://endnote.com/if/online-user-manual 

 

Formatting Text in a single EndNote Reference 

The general rule is that you do not format your references with bold, italics, underlining or punctuation. 

EndNote does all of that formatting automatically. The reference style you select for your document governs 

the style of in-text citations and bibliography.  

There are some occasions, eg; entering scientific names - Southern royal albatrosses (Diomedea 

epomophora), where you may need to format a piece of text.  In these situations you can use the formatting 

options at the top of the reference window.   

 

 

Accessing Records from the Catalogue 

There are two ways to get results from the Library Catalogue into Endnote: 

 

Option 1: Use the Online Search Method (searching within Endnote) 

 

Currently the most reliable method of getting results from the Library Catalogue into EndNote is to use the 

Online Search method.  

Before starting any Online Search make sure your library is displaying in the  

Online Mode.  To select the Online Mode click on the picture of the globe at the  

top left of the library window.  

 

Step 1: Search for References 

1. Tools >> Online Search    

2. Select U Auckland from the list of connection files and click Choose. 

EndNote has now established a link into the Library Catalogue and the EndNote search tab will show 

‘Search Remote Library’. 

3. Enter the search term e.g. egyptian tombs into the first search box 

 

http://endnote.com/if/online-user-manual
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4. Change the Author option to Any Field and click Search. 

5. EndNote will search the Library Catalogue and display the references that match your search term. 

 

Step 2: Retrieve References 

1. You will now be given the option to retrieve the references. 

2. Retrieve all the references from the search by clicking OK. The references will be downloaded and  

will appear in the Retrieved References window.   

NB: If your result set is too large you can choose just to retrieve a section of the results OR click 

Cancel to return to the search screen and add further terms to your search. 

 

Step 3: Save References  

1. Review the retrieved references.  These references are not actually part of your EndNote library yet.  

If you closed EndNote now they would not be saved. 

2. Select the references you want to save.   If you want to save only a sub-set, hold down the Ctrl key 

and click on the individual references. 

3. The selected references can be copied into your EndNote library by clicking References >> Copy 

References To>> choose your library name.  

IMPORTANT: To view and use your EndNote Library you need to now change from Online Mode to 

Integrated Mode.   A pop-up box will ask if you want to discard the online references, if you have 

finished copying references, click OK.  

 

 

Option 2: Export from Library Search (not recommended – please check references for accuracy 

after exporting) 

 

1. Open Library Search  

2. Enter the search term coastal erosion into the search box 

3. Add the first five items on the results list to your My Library account 

4. Go to your My Library account and select all items 

5. Select Push to Endnote from the Select How to Save menu (*note: these items should directly export  

into your Endnote account)  
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Use Groups to Manage your References 

 

Groups are displayed in the left column of your library. The groups: All References, Unfiled and Trash will 

always show.  Some groups will appear only when you have used certain EndNote functions, e.g. Search 

Results, Copied References.     

 

You can also create up to 500 of your own custom groups to help manage your references. Custom Groups 

are like folders. References are only included in a group if you add them. 

 

Creating a Group 

1. From the Groups menu select Create Group  

2. A box will appear under the My Groups heading. Type your group name in here e.g. egyptian tombs 

 

Adding References to a Group 

1. In All References select the reference(s) you want included in the new group.  

2. From the Groups menu select Add References To >> egyptian tombs 

 

Removing References from a Group 

1. In a group select the reference(s) to be removed  

2. From the Groups menu select Remove References From Group 

 

Deleting a Group 

1. Click on the group name in the left column to display the group you want to delete 

2. From the Groups menu select Delete Group. 

 

You can add a single reference to more than one group.  Adding a reference to a group does not remove it 

from your main library (All References). This means you can remove a reference from a group but it will still 

be included in your main library (All References).  If you delete a reference from your library (All References), 

it will be removed from all groups and permanently deleted.  
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Work with References 
 

Each row in the main window represents a single reference. Each reference in the library contains the 

citation details, author, title, journal title, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To delete a reference from your library click on the reference and then go to  

References >> Move References to Trash 

 

 

Changing the Fields Displayed in the Library Window 

By default, EndNote displays the Read/Unread Status, File Attachments, Author, Year, Title, Rating, 

Journal/Secondary Title, Last Updated, and Ref Type for each reference. You can display up to ten fields. 

 

To change the columns displayed in the library window:  

1. From the Edit menu, choose Preferences. 

2. Select Display Fields from the list on the        

 left side of the preferences window. 

3. Select the columns to display. By default,        

 EndNote will use the generic field name as        

 the column title; you may use different text          

  as the column title by entering that text in             

  the "Heading" text box corresponding to        

  each column. 

4. Click OK to confirm your selection. 

 

 

 

Re-order the list of references by clicking on the title of the 

column you want the references sorted by, eg: author, year. 

Adjust the column widths by dragging 

the bar between column headings. 
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Search your Library 

 

As your Library increases you will need to be able to easily search for specific references.  There are two 

search functions available in EndNote which search across both your references and the text of any 

attachments you have saved within your Library. 

 

Quick Search 

In EndNote at the end of the toolbar there is a Quick Search box. Enter your search word(s) in the box and 

press Enter.  The results will be displayed. To view all references in your library again select References  >>  

Show All References 

 

Search Tab 

If you want more search options then you need to use the Search Tab.  Above the references in your library 

you should see a preview pane. Choose a search option, and enter some key-words to search. 

 

 

T 

 

 

 

 

 

Track and Rate your References 

EndNote has several options for tracking your references. 

 

Read or Unread Status 

 

 

 

 

 

 

 

To search on word variations use the asterisk for a wildcard e.g. to 

search for all variations of the word free search for free* 

 

 

To search for text within 

PDFs choose the Any Field + 

PDF with notes from the 

drop-down menu. 

To change the status of references to ‘read’ or ‘unread’: 

 From your library, double-click on a reference to open. 

 Click the Mark as Read/Unread icon to change the status of your 

reference. 

Note: EndNote automatically marks a reference as read when you view it in the 

reference window. You can change Read/Unread preferences by going to Edit > 

Preferences > Read/Unread. 
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Rating your References 

 
To rate your references: 

 From your library, double-click on a reference to open. 

 

 

EndNote and Microsoft Word 

EndNote and Microsoft Word 

 

Cite While You Write 

 

The EndNote Cite While You Write (CWYW) functions allow you to easily and quickly cite references and 

create a document with properly formatted citations and bibliography. These Cite While You Write functions 

are available from the EndNote tab on the Microsoft Word ribbon. 

 

EndNote Citation Styles 

 

Before creating your document in MS Word you need to select a reference style. Styles are used to 

determine the format for your citations and references.  Styles are typically for specific journals, though they 

can also be based on more general style guides such as the Chicago Manual of Style or the MLA Handbook. 

EndNote provides hundreds of preconfigured styles.  You should always check with your supervisor or 

department as to which style to use. In rare cases you may need to make minor alterations to the style you 

have chosen if it does not quite fit your requirements. Consult the full EndNote manual for instructions on 

editing a style. 

 

Select a Style 

EndNote contains many referencing styles for you to 

choose from. If you are unsure which style to use, ask 

your lecturer, tutor or supervisor.   

 

To choose a style:  

1. Edit >> Output Styles >> Open Style Manager 

 

2. The EndNote Styles box will display 

 

3. Select the style you want by clicking in the        

              tick-box beside it. For example we will select           

              the APA 6th style.  You can select more than   

 

 Apply a rating to your references in the main reference window by clicking on each star 

directly.  

Note: You can search by rating by selecting the ‘Rating’ option from the Search Field list. 
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              one style.  

 

4. Click on the cross to close the EndNote Styles         

               box. 

  

Note: If the style you want does not show in the list of options you may need to go to the EndNote website 

and download a style.  Further information on this can be found in Chapter 17 of the full EndNote manual. 

 

Saving Additional Styles 

If the style you want does not show in the list of options you may need to go to the EndNote website 

(http://endnote.com/downloads/styles) to download a style.  Save the style file in a folder (eg: 

endnotex5styles) in one of the following locations :  

 C:\Documents and Settings\[User Name]\My Documents\ (for Windows XP)  

 C:\Users\[User Name]\ Documents\ (for Windows Vista or Windows 7).  

You will need to make sure the EndNote folder locations match where you are saving the styles. In EndNote 

select Edit > Preferences > Folder Locations to check the locations. 

 

 

Insert Citations 

Inserting Citations from MS Word 

In your document type the following quote:  

“Residents of Great Barrier Island have mixed reactions to the 

possibility of mining on the island.” 

At this point we need to insert a citation for this quote. The reference 

we wish to insert is the Great Barrier Island reference that we 

entered earlier.   

 

To insert the citation from MS Word: 

1. Choose the EndNote tab >> Insert Citation >> Find Citation  

2. The EndNote Find Citations box  will appear so you can search    

               for your reference. 

 

The style currently used in your EndNote library is 

displayed at the top of the screen. The default style is 

usually the Annotated style.  

To select the style you have just chosen click on the 

drop-down option.  Click on the style you want, e.g. 

APA 6th. 

Your style is now selected and all citations and reference lists will be formatted by the rules 

governing the style. If you need to change the style for any reason, then simply repeat the steps 

above. 
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3. Type the author’s name, e.g.   

              Brownlee 

4. Click Find 

 

 

 

5. Select the appropriate reference and click Insert at the bottom of the box. 

6. The citation should now appear in your document. 

 

 

 

Inserting Citations from EndNote 

 

1. Type another sentence in your word document.  Position your cursor at the end of this sentence and 

type a space. At this point we wish to insert two references. 

2. From Microsoft Word you use the EndNote tab  >>  Go To EndNote        

3. In your EndNote library locate and select two references.  (If you want to insert more than one 

reference at the same point in your MS Word document at the same time, hold down the CTRL key  

when selecting your references.) 

4. Tools >> Cite While You Write  

(CWYW) >> Insert Selected Citation(s ) 

5. The references appear in the text  

and in the list that is building at the  

end of the document. 

 

 

 

 

 

 

 

If you can’t remember the name of the first author, you could enter 

in the name(s) of other authors, or keywords from the title or other 

relevant fields. It is also possible to select text in your MS Word 

document and then choose the ‘Find Citation’ option to find the 

selected text. 

The EndNote Find Citations dialog box will show the finds that resulted from your search. 

 If your search resulted in more than one find, you will need to select the correct reference citation for the 

idea you are currently citing. 

 If no finds were found, you will need to try again.  

 Note that if you do not have the EndNote software (and your library) open, no finds will be generated 

from this procedure; ensure that both are open before attempting to find citations. 
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Inserting Footnotes 

 
If you are using a footnote style, (e.g. Chicago A), you will need to insert a footnote in Microsoft Word prior 

to inserting references from Endnote. 

1.      In Word 2010, select  References > Insert Footnote.  

2.      From Word, select the EndNote Tab > Go to EndNote.                                                               

3.      Find and highlight the required reference in EndNote.    

4.       Back in Word: position your cursor in the note. Then go to Word’s  EndNote Tab, click Insert Citation 

Insert Selected Citation(s) 

 

 

Edit Citations 

 

The way your citations appear in the text of your document may not always be formatted as you require.  

Sometimes you may need to include a prefix, suffix, or page reference, or to exclude the year or author.  For 

example the in-text citation may be - (Nugent, 1998) - but you would prefer it too look like - (Nugent, 1998, 

p. 1077) or … as reported by Nugent (1998, p.1077) 

EndNote has a specific function for editing citations.  You must use this function to edit citations.  If you try 

to change citations by manually typing or deleting in the Word document the changes will not be retained.  

The citations will soon revert to their original form. 

 

To make changes always follow these steps: 

1. Insert  the citation in the document 

2. Place your cursor somewhere inside the citation to be formatted (it should turn grey) 

3. From the EndNote tab choose  Edit and Manage Citation(s)  

4. The EndNote Edit and Manage Citation dialog box is displayed 

5. All references in the document are displayed in the top part of the pane.  The reference you have 

chosen should be selected.   

6. Use the Edit Citation options in the Edit Citation pane to exclude the required information then click 

the OK button to confirm changes.   
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Note: to correct details in a reference click on the Edit Reference item next to the incorrect reference.  This  

will take you back to your Endnote Library where you can open the reference and correct it.  Then close the 

reference to save the changes.  To update the changes in your Library select Update from My Library using 

the Edit Reference drop down box.  

 

Suffix option 

The suffix option allows you to add text at the 

end of your citation such as page numbers. Type 

your text exactly as you wish it to appear, 

including spaces and punctuation. 

To include a page number in the in-text citation, 

in the suffix box type the page number and the 

necessary punctuation, for example p. or pp and 

commas and full stops if required , p. 1077. 

Pages option 

This option allows you to specify page(s) for 

citations, e.g for direct quotes. This option is 

only reliable for ‘footnote’ styles.  For ‘author-

date’ type styles you can enter your page(s) into 

the ‘suffix’ field. 

Exclude author & year options 

If you wish to remove the author or year from 

your citation, then use the formatting drop 

down box and select the appropriate option. 

Use these options when the author or year is 

already part of the sentence. For example: 

Cadman (1997) has stated … 

 

Prefix option 

The prefix option allows you to add text to the beginning of 

your citation such as ‘for example’, ‘as cited in’ etc. When 

you enter your text, ensure it is entered exactly as you wish 

it to appear and at the end of the text include a space 

(otherwise there will not be a space between your prefix 

and the citation). 
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Back-up your EndNote Library 

 

It is essential that you make a backup of your EndNote library in case disaster strikes!  As well as saving a 

copy on the computer you are working on it would also be useful to save a copy on another disc or drive.  

You can use this copy to restore your lost or damaged EndNote Library. When backing up it is essential that 

you keep copies of both the .enl and the .data files. The .data folder contains attached files, terms lists and 

group information.   

 

 

 

 

Save a Copy 

You can save a copy of both your .enl file and its associated .data file to use as a backup or to send to 

someone using EndNote.  

1. Open the Library in EndNote 

2. From the File menu, select Save a Copy 

3. Use the file dialog box to select where you want to save your back-up copy.  

 

Save a Compressed Copy 

You can save your complete library (both the .enl and the .data file) to a single compressed file. The single 

file will be an .enlx file that you can restore (unzip) with Endnote. 

1. Open the library in Endnote 

2. From the File menu, select Compressed Library 

3. Choose the appropriate Compressed Library options (see below) and then click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Choose to save a 

compressed library 

or save and then email a 

compressed library. 

 

Choose whether or not to 

keep the file attachments. 

NOTE: without file 

attachments libraries are 

much smaller in size and 

therefore easier to email to 

others. 

 

Choose whether to 

compress the whole library, 

only the references you 

have highlighted in your 

library or a specific group of 

references. 
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How to get EndNote & Help 

The latest versions available at The University of Auckland are version X6 for Mac and version X6 for 

Windows. 

 

EndNote at the University 

EndNote is installed on most University computers, in student computing laboratories and staff and graduate 

offices, and in the Library. If EndNote is not installed on a computer that you are using please contact the IT 

support person for your department/faculty.   

 

EndNote at Home 

 Students – EndNote X6 is available to purchase on CD from the Kate Edgar Information Commons, 
the Grafton Information Commons, the Epsom Information Commons and the Tamaki Information 
Commons. The cost is $60.00.  

 Staff - Please contact computer support staff for you department/faculty if you wish to have 
EndNote installed at home. 

Installing or Upgrading EndNote 

 

If you are upgrading your EndNote version, it is recommended that you uninstall earlier versions. Before you 

uninstall an earlier version, you must backup any styles, import filters and connection files that you don't 

want overwritten.  

 

If you are working on a word document using your EndNote library then you must un-format the word 

document before upgrading your version of EndNote.   

 

Important Note: If you are collaborating or sharing EndNote files with a colleague you should all use the 

same version of EndNote. 

 

System Requirements  

Information about the system requirements and word processor compatibility for EndNote can be found on 

the following webpages for both Windows and Macintosh: 

http://endnote.com/en/requirements 

 

Help 

 The Library Web Page: http://www.library.auckland.ac.nz/endnote/endnote.htm 

 The official EndNote Web Page:  http://www.endnote.com 

 EndNote contains a useful quick guide, which is available whenever you use your computer. You can find 

it via Start >> All Programs >> EndNote >> Getting Started Guide, or locate the .pdf file in the EndNote 

folder on your C:\ drive. You will need Adobe Acrobat Reader to view the manual and it can be 

downloaded free from: http://www.adobe.com/support/downloads/ 

 The official and more comprehensive 800 page EndNote manual is also available on the EndNote website: 

http://endnote.com/if/online-user-manual  

http://endnote.com/en/requirements
http://www.library.auckland.ac.nz/endnote/endnote.htm
http://www.endnote.com/
http://www.adobe.com/support/downloads/
http://endnote.com/if/online-user-manual
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PART TWO 

Direct Export results from a Database 

 

Direct export is the quickest and easiest method for getting references from a database into EndNote.  Not 

all databases offer a direct export option.  To find out if a database supports direct export you can check any 

of the following: 

 the help within a database 

 information on the database Connect Page  

 information in the full EndNote manual under ‘Appendix D: Direct Export Formats and Import 

Formats’. 

 

Example: Direct Export from the Medline Database: 
 

1. Open the Medline OvidSP  

              Database. 

2. Search for chicken pox 

Tick the Full Text box, and  

un-tick the Map  

Term to Subject Heading  

box. 

 

3. Select some of the results by ticking the box next to the result number 

4. Find the options above the first result and click Export 

 

 

 

 

 

 

 

5. From the Export To drop-down menu choose EndNote 

6. Select Complete Reference 

7. Click Export Citation(s) 
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Add a File Attachment  

 

You can attach files with full-text journal articles (e.g. PDFs) in your EndNote library. This allows you to 

conveniently store articles or notes and use EndNote as a file management tool as well. 

1. Select the reference you want to attach the file to. 

2. From the References menu select File Attachments >> Attach File. 

3. From the dialog box locate the file you saved earlier.  At the bottom of the screen you will see this 

option: 

 

If this box is not ticked then the file will not be copied into EndNote.  Only a file path to where the 

article is saved will be added to the reference. 

4. The file is attached to the reference in your EndNote Library and an icon will appear in the File 

Attachments field.   Double-clicking the icon will open the appropriate program for you to read the 

file. 

5. The original file that was saved earlier is now duplicated in your EndNote .data folder. The original 

file can now be deleted. 

When you insert a file into an EndNote reference, EndNote saves the file in a data folder in the same location 

as your EndNote library. The data folder will have the same name as your library, plus the .data file 

extension. For example if your library was named mylibrary.enl the folder where images are stored would be 

named mylibrary.data.  If you need to delete a file from EndNote, open the EndNote reference, scroll to the 

File Attachments field, select the icon and press the Delete key on your keyboard.  Warning: If you delete the 

file within the Reference, it is also deleted from the .data folder. Make a copy of the file before deleting it 

from a reference if you want to retain a copy. 

 

 

 

 

 

In order to demonstrate another feature of EndNote you need to save one reference from the Medline database in 

PDF format: 

1. Return to the window displaying the Medline search results 

2. Find a reference with the option PDF Full Text and click on the link 

3. From the Adobe toolbar (not the web browser toolbar) click the Save icon. 

4. Rename the file (the default filename is a long sequence of letters and numbers) the author’s surname is a good 

choice for filename, and save the file to the desktop. 

5. You can then Log off from Medline 
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Work with PDFs 

 

1. Highlight the reference and use the preview window on the right hand side of the screen. 

 

 Use the Reference Tab to: change any reference details and add your own text to the Research 

Notes field.   

 Use the Preview Tab to: see a preview of the citation. 

 Use the Attached PDF Tab to: view the attached PDF. You can also Email, Print or Zoom etc. by 

using the appropriate buttons.  To annotate PDFs using the “sticky note” feature from within 

Adobe Acrobat – click on the furthermost arrow on the options ribbon. 

 

 

 

 

 

 

 

 

 

 

2. Open the reference from the library window by double clicking on it, from here you can: 

 

 Change any reference details and add your own text to the Research Notes field.   

 View attached PDFs by opening the PDF from the file attachments field 

 Annotate PDFs using the “sticky note” feature from within adobe acrobat 

 

 

 

 

 

 

 

 

 

 

 

Note: To save any changes made to a reference or to an attached PDF you must close the reference (Ctrl-W).  

You will then be prompted to save. 
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Import Records using a Filter 

 

What is an Import Filter? 

An import filter is a file used by EndNote to import references contained in a data file. A data file contains 

records captured or saved from a database. A filter instructs EndNote precisely how to interpret the 

information in the data file, and copies the information in each field to the corresponding field in EndNote.   

Each filter is unique to a specific database and its provider e.g. a filter for Medline from Ovid will be different 

to a filter for Medline from Ebsco. 

 

Using an import filter is a two-part process 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example: using a filter to transfer results from INNZ to EndNote 

 

Part 1. Downloading References from INNZ : Index New Zealand 

1. The Library website >> Databases & Article Searching >> I >> Index New Zealand: INNZ 

2. At the top of the Connect page click Connect, and  Search for tuatara 

3. Find the Full Record Options section underneath the results  

4. Make the following selections and click Print/Save 

(You can tick the boxes next to each citation to save individual citations if you don’t want them all) 

 

 

 

 

 

 

1. Save references from the database 

into a file in an EndNote compatible 

format. 

 

2. The file is then imported into EndNote 

using the appropriate import filter. 

 

 

Saving Additional Import Filters 

EndNote comes with hundreds of standard import filters that correspond with most of the Library 

databases that don’t have a direct export option.  In some cases the import filter you require may not be 

available in EndNote, these filters can be downloaded from the Library EndNote web page 

(http://www.library.auckland.ac.nz/endnote/endnote.htm). 

Save the filter file in a folder (eg: endnotex6filters)in one of the following locations :  

 C:\Documents and Settings\[User Name]\My Documents\ (for Windows XP)  

 C:\Users\[User Name]\ Documents\ (for Windows Vista or Windows 7).  

You will need to make sure the EndNote folder locations match where you are saving the filters. In 

EndNote select Edit > Preferences > Folder Locations to check the locations. 
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5. Use the internet browser options to save the results.  

6. Save the .txt file to your desktop. You may want to rename the file to make it easily identifiable. 

7. Click the back button to see the results in INNZ and then exit the database. 

8. You have now saved references from the database in an EndNote compatible format and you are 

ready to import those references into EndNote. 

 

Part 2. Importing Downloaded References into EndNote 

1. Open EndNote (Start >> Programs >> EndNote >> EndNote Program) and open the library into 

which you want to import your references. 

2. File >> Import     

3. Click Choose File... to locate and open the  

file you saved above. 

4. Double-click your file name, or highlight it        

and click the Open button, the file name  

is pasted into the box. 

 

5. Click the Import Option drop-down menu  

and select  the database you are importing from.   

If your chosen filter has not previously been used on EndNote it will not appear on the drop-down 

list of filters.  You can find it by choosing Other Filters from the Import Options list. 

6. In the Choose an Import Filter window scroll through the list of available filters and select INNZ.  

Once you have used an import filter EndNote retains that setting so the filter is ready for use next 

time and appears in the Import Options drop-down list. 

7. Select an option from the Duplicates list.  A reference is considered a duplicate if the Author, Year, 

Title, and Reference Type match a reference already in the library. You can choose to:  

a. Import All:   Imports all references, including duplicates. 

b. Discard Duplicates:  Imports all references except duplicates. 

c. Import into Duplicates Library:  Duplicate references are imported into a library called FILE-

DUPL.ENL where "FILE" is the name of the library into which you are importing. Sometimes 

EndNote won’t detect duplicates because of minor variations or errors in citations, so you 

should always check your references after they have been imported. 

8. Click the Import button to import the file. 

 

 

When the import is complete, only the newly imported references will show in the Library window.  This 

is an intermediate stage which gives you the opportunity to modify references as required before they 

are aggregated into the main library.  At this stage you can check individual records to ensure the data 

has been imported into the correct fields, or add your own research notes. 

9. To view your complete library Click All References. 

 

Importing another EndNote Library 
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If you can’t access your existing EndNote library and want to save references to EndNote you can create a 

new library for that day and then import it into your existing library later.  You can also use this method if 

you want to import an EndNote library someone else has sent you into your library. 

1. File >> Import     (This will open the Import dialog box). 

2. Click the Choose File button and find the library (.enl file) you wish to import. 

3. In the Import Option box select  EndNote Library from the drop-down menu  

4. In the Duplicates option select Discard Duplicates or Import into Duplicates Library. 

5. Leave the Text Translation option as No Translation. 

6. Press the Import button to import the other library into your own. 

 

Importing References from PDF files 

Endnote allows you to import PDF files, or folders of PDF files, directly into your Endnote Library.  The import 

process automatically attaches the PDF to an Endnote reference and populates some of the reference fields.  

Please be aware that the amount of information that comes across depends on the age and source of the 

PDF and in some cases, particularly for older files, the import might not be successful.  

1. File>>Import  (This will open the import dialog  box) 

2. Click the Choose File (or Folder for a folder of PDFs) and navigate to your saved PDF document(s) 

3. In the Import Option box select PDF from the drop-down menu 

4. In the Duplicates option select Discard Duplicates or Import into Duplicates Library 

5. Leave the Text Translation as No Translation. 

6. Press the Import button to import the other library into your own. 

 

 

Use Groups to Manage your References 

 

The groups you can create fall into three categories;   

custom groups, smart groups and group sets. 

 

 

Group Sets 

Group Sets allow you to form a two-tier 
hierarchy with your groups.  
 

 Creating a Group Set 

1. From the Groups menu select Create Group Set. 

2. A box will appear in the left column. Type your group name in here, eg: Psychology 101 

 

 

Adding Custom Groups or Smart Groups to a Group Set 

1. Follow the steps above to create the Custom and/or Smart Group  to be included in the Group Set.   

 Group Set 

 Custom Group 

 Smart Group 
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2. Once created click and drag the name of the group you want onto the name of the set.  

 

Smart Groups 

 
Smart Groups are like rules in your email program.  You set up a search and any time a reference is added to 
the library that meets the search parameters it is automatically added to the smart group. 
Smart Groups can be identified by the light-bulb and magnifying glass icon next to the group. 
 
Creating a Smart Group 

1. Enter the search you want in the Search Pane 

2. Click on the Options button and choose Convert to Smart Group 

3. An option to name the Smart Group will appear in the left column, type your group name here. 

 

Format the Reference List 

 
Change the appearance of the reference list at the end of a document, eg: font or line spacing.  
 

1. In Word, choose the EndNote X6 tab. Click on the arrow icon to the right of Bibliography  

 

  
 

 

 

2. Select the Layout tab, and use the options in this window to change the layout 

 

 

 

 

 

 

 

 

 

 

 

 

 

Choose the font and size you want 

your reference list to be displayed in. 

Choose whether or not you want a 

heading at the beginning of your 

reference list. 

Adjust the indents within a reference 

or the spacing between references. 
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Unformat and Reformat a Document 

 

There are a number of reasons why you may need to unformat and reformat the EndNote citations in your 

document.  

 If you need to work on multiple computers and they have different versions of Word, it is safest to 

save and open your document in an unformatted state. 

 If you are working on a long document and need to change the referencing style it is best to 

unformat to remove the formatting from the old style before formatting in a new style. 

 If you need to copy large sections of your document to another document – especially when 

compiling a thesis from separate chapters into one file – it is best to do this in an unformatted state. 

 Some people prefer to work on an unformatted version of their document as it is often faster and 

they do not want to see their reference list as they work. 

 

 

Unformatting 

1 From the ribbon in Microsoft Word, choose the EndNote X6 tab  

2 Select Convert Citations and Bibliography 

3 Four options will appear, select Convert to Unformatted Citations 

 

 

 

 

 

 

 

 

Reformatting 

1 From the ribbon in Microsoft Word, choose the EndNote X6 tab  

2 Make sure the style you want the document formatted in is showing in the Style window 

3 Select Update Citations and Bibliography 

It is possible to use this command on both formatted and unformatted documents.  If your document is 

already formatted it will simply update it for you.  If your document is unformatted then all citations will be 

formatted and a reference list created.  

 

 

 

 

 

 

 

 

 

 

This is the reformatted 

document using Numbered 

style. 

 

This is how your document 

will appear if you have 

instant formatting turned 

off or wish to work with an 

unformatted document. 
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Mismatched Citations 

 

When EndNote formats your document it may have  

difficulties matching the unformatted citation in  

your document with a specific citation in your library.    

If this occurs a dialog box will appear.  

 

Each ‘problem’ citation will be identified in turn,  

and you will have the following options: 

 EndNote will provide suggestions for possible  

replacements. If one of these is suitable, select  

the citation in this window and press the Insert  

button - the mismatched citation will be replaced. 

 If none of EndNote’s suggestions is appropriate you can search your EndNote library from the dialog box 

that appears and find an alternative yourself. When you have found the relevant citation, select it and 

press the Insert button to replace the mismatched citation. 

 If you do not wish to fix the problem at this stage, choose the Ignore button. This means that the citation 

you chose to ignore will not be formatted, however you can of course come back to it later. 

Generally, if EndNote cannot find a citation it is either because you have accidentally deleted it from your 

library, or have made an alteration to it that has resulted in EndNote being unable to identify it. If the former 

is the case you will need to re-enter the citation. When you reformat your bibliography, EndNote still will not 

identify it but you will be able to locate it in your library and re-insert the citation. 

Note that if you have used the indicators {and } for text other than EndNote citations, EndNote might bring 

up these instances – choose to ignore them.  

 

Unformatting and Reformatting when Compiling a Thesis 

 

One of the most common reasons for using the unformatting and reformatting options is to combine 

multiple chapters into a single thesis document.  Follow the steps below to ensure this is done smoothly.   

 

1. Unformat the separate chapters and temporarily remove any reference lists. 

 Follow the instructions above to unformat a chapter.   

 Save your chapter under a different name, eg: chapter1unformatted.doc.   

 Repeat this process for all chapters.  

2. Insert your chapters into a single document. 

 Open a document and create any preliminary pages (eg: title page, abstract).  Position your cursor 

after the preliminary pages. 

 From the Insert tab, in the Text group, click Object >> Text from File… 

 Select the file you want to insert, eg: chapter1unformatted.doc, and click Insert 

 Move your cursor to the start of the next section and follow the steps above to insert the other 

chapters. 

 

3.  Reformat your document and recreate a reference list. 
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 Follow the instructions above to format the complete document and your reference list will be 

added to the end of the document. 

 If you do not want your reference list at the end of your document, cut and paste it to the 

appropriate location. 

For further information, book and attend a Student Learning Centre Course on compiling a thesis. 

 

 

Removing Field Codes (convert to Plain Text) 
 

When you insert citations into Word, they have ‘hidden codes’ attached to them. These codes allow 

EndNote to format, un-format, and re-format citations. If you are going to submit your work to a publisher or 

any other situation where you are sending the document without attaching your library you must remove 

the field codes first.  

 From the EndNote tab select Convert Citations and Bibliography. Three options will appear select Convert 

to Plain Text. This process will create a plain text copy of your document which you should then save under a 

new name. Note that this copy cannot be re-formatted by EndNote.  Any changes should be made on your 

original. 

 

Create Bibliographies: general, subject and annotated  

 

EndNote creates what is known as a ‘reference list’ at the end of your document i.e. a list of all works 

actually cited. Some disciplines require a bibliography as opposed to (or as well as) a reference list i.e. a list 

of all works consulted or read. There are functions within EndNote that you can use to create different types 

of bibliographies. 

EndNote X6 can create a general bibliography (i.e. a listing of a selection of references), a subject 

bibliography (i.e. listings under particular headings) or an annotated bibliography (i.e. a listing of references, 

each including an abstract).  

 

General Bibliography 
 

There are many ways to create a general bibliography.  One of the simplest is to use the Copy Formatted 

command. 

1. In EndNote, select the references you want to include in the bibliography 

2. Check that the appropriate style is displaying in the EndNote toolbar 

3. Edit >> Copy Formatted (or Ctrl+K) 

4. In MS Word, use the paste option (or Ctrl + v) to add the references to a document. 
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Subject Bibliography 
 

Subject bibliographies consist of various listings under particular headings (such as keywords, authors, or 

publishers).  

1. Choose the records in EndNote you want for a separate bibliography, perhaps a selected group instead 

of the whole library. Highlight your selected references and then click References >> Show Selected 

References. 

2. Select an appropriate style from the Style Manager . 

3. Tools >> Subject Bibliography. 

4. The Subject Fields window displays a list of all the  

different fields that a reference can have. 

5. Select the field (or fields) that you want to sort your  

bibliography by, eg: keywords.   

6. Once you have chosen your field click OK.  A list will be  

displayed of the various terms found within this field  

and the number of references in your EndNote Library  

containing each term.  

7. Select the terms to be included in the bibliography by 

 holding down the Ctrl key as you click the terms you want, or click Select All to include them all. 

8. Then click OK and your subject bibliography is created in a new window.  Use the Layout button at the 

top of the screen to change some features before saving or printing the bibliography. 

 

 

 

Annotated Bibliography 
 

Using the Annotated Style 

The simplest way to create an annotated  

bibliography using EndNote is to use the  

Annotated Style.  This will display your  

results with the information from the  

Abstract Field under each reference.  

 


